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1. Introduction to mikroC PRO f

mikroC PRO for ARM® organizes applications  [Grecrosas =)

Fie Edt View Project Buid Run Tools Help

into projects consisting of a single project file BB IEES|0d 0 HOME SRS BAIART, N Qe AR 0.2
2 Code Bxplorer (57 [ edminkng.c = - e

(file with the .mcpar extension) and one or ity | . T —
more source files (files with the .c extension). e @7 :

The mikroC PRO for ARM® compiler allows you to - 1

manage several projects at a time. Source files ° wwimw )

can be compiled only if they are part of a project. i@ TE

Name:  L3s5895
.ixzoc pro .

A project file contains: g oyt T o, o sose uahs ac 9
* Project name and optional description; Eemmer_wwodiesl SR .,

5 Buld/DebuggerType. )| P10 pigital output (sGPIO PORTA DATA BITS, GPIO PINWASK ALL); // Sst PORTA as digital

. . B v
» Target device in use; T || Coio_oranes_outpo (4Geto_sonro .ot _ceio A ALY | /) Set FoRes o disice [ e T
 Device clock: 20l | Ge10_p2gata1_output (s6P10_POKID DATA LTS, P10 PINMAS 17 Set BORID a3 argatai | | @i | ENENE) | s

© Sofware: © Hardware: - GPIO Digital Output (§GPIO PORTF DATA BITS, GPIO PINMASK ALL): // Set PORTF as digital™

e List of project source files; T T

* Binary files (*.emcl); and P L 1 — .
) . - o i 0 D i 5691 Suscnibians omn | 2
e Other files. ° e RO bt 710 10 oG 8407 einon by 70 o 0—@
: = T B
In this reference guide, we will create a new project, T — Compied E ARPRO 7 STELARS VA

write code, compile it and test the results. The
purpose of this project is to make microcontroller @ Main Toolbar @ Project Settings @ Code Editor @ Project Manger
PORTA LEDs blink, which will be easy to test. @ Code Explorer @ Messages @ Image Preview @ Library Manager
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2. Hardware connection

Let's make a simple "Hello world” example for the
selected microcontroller. First thing embedded
programmers usually write is a simple LED blinking
program. So, let's do that in a few simple lines of C code.

Figure 2-1: Hardware
connection schematic

vocs

awr ar axr Kt

oo N Lot w2 N D3 N
LED LD LD LED

LED blinking is just turning ON and OFF LEDs that are LM359B95

connected to desired PORT pins. In order to see the
example in action, it is necessary to connect the target
microcontroller according to schematics shown on
Figure 2-1. In the project we are about to write, we
will use only PORTA, so you should connect the LEDs
to PORTA only.

Pag
Pa1

K ] x| ax,

s M DS 105 M L7, ~
LED LED LeD. LeD

Prior to creating a new project, it is necessary to do the following:

Step 1: Install the compiler Step 2: Start up the compiler
Install mikroC PRO for ARM® from the Product DVD or download it  Double click on the compiler icon in the Start menu, or on your
from the MikroElektronika website: desktop to Start up mikroC PRO for ARM®. The mikroC PRO for ARM®

‘ IDE (Integrated Development Environment) will appear on the
http://www.mikroe.com/mikroc/arm/ . .
Lj screen. Now you are ready to start creating a new project.

Page 5



The process of creating a new project is
very simple. Select the New Project option
from the Project menu as shown below.
The New Project Wizard window appears.
It can also be opened by clicking the New
Project icon from the Project toolbar.

Eru:lject|ﬂui|d Bun Tools Help

F' Mew Project... Shift+Ctrl+ N
E® Open Project... Shift+Ctrl+ 0
@ Open Project Group...

Recent Projects 3

The New Project Wizard (Figure 3-1) will
guide you through the process of creating
a new project. The introductory window of
this application contains a list of actions to
be performed when creating a new project.

Click Next.

Mew Project Wizard

Welcome to the New Project
Wizard

This wizard helps you:

Create a new project

Select the device for your project
Setup device clock

Add project files

Click Next to continue

e [

Cancel |

Figure 3-1: Introductory window of the New Project Wizard



First thing we have to do is to specify the
general project information. This is done
by selecting the target microcontroller, its
operating clock frequency, and of course
- naming our project. This is an important
step, because the compiler will adjust the
internal settings based on this information.
Default configuration is already suggested
to us at the begining. We will not change
the microcontroller, and we will leave the
default LM3S9B95 as the choice for this
project.

New Project Wizard lihj

Step 1: Project Settings:

Project Name: MyProject

Project folder: C:\Users\Public\Documents\Waork), B e
Device Nama: LM355B55 -
Device Clock: 16000000 MHz

Enter project name, project folder, select device name and enter a device dock
(for example; 956.235).

Note: Project name and project folder must not be left empty.

4 Back Next & Cancel

Figure 3-2: You can specify project name, path, device and clock in the first step



If you do not want to use the suggested
path for storing your new project, you can
change the destination folder. In order
to do that, follow a simple procedure:

Click the Browse button of the Project
Settings window to open the Browse
for Folder dialog.

Select the desired folder to be the
destination path for storing your new
project files.

Click the OK button to confirm your
selection and apply the new path.

[ Mew Project Wizard

Step 1: Project Settings:

2 .
Browse For Folder w

4 Public Documents -
i | mikroElektronika
s RAD Studic
& 4 Rentcom
[l Work]|
J‘} -Music )
I (] Pictures

B Videos N

[}

|

Inikeamikorot

-

device dock

pty.

Browse

’ Make New Folder J I oK _] | Cancel | l

Cancel

Figure 3-3: Change the destination folder using Browse For Folder dialog




| Mew Project Wizard [i_:hj

Once we have selected the destination Step 1: Project Settings:
project folder, let's do the rest of the project
settings: Project Mame:
Project folder: C:\Users\Public\Documents\Work, Browse
Enter the name of your project. Since Device Name: LM359895 )

we are going to blink some LEDs,
it's appropriate to call the project
“LedBlinking”

Dewvice Clock: 16.000000 MHz

For this demonstration, we will use Enter project name, project folder, select device name and enter a device dock
the default 16MHz clock. Clock speed (for example: 96.235).

depends on your target hardware, and Note: Project name and project folder must not be left empty.
whether you are using PLL or not. But
however you configure your hardware,

make sure to specify the exact clock
(Fosc) that the microcontroller is # Back Next % Cancel

operating at.

) Figure 3-4: Enter project name and change device clock speed if necessary
Click the OK button to proceed.



Mew Project Wizard Lﬂ_hj
This step allows you to include additional Step 2: Select files you want to add to project.
files that you need in your project: some
headers or source files that you already Add File To Project:
wrote, and that you might need in further @) add
development. Since we are building a : Remoye
File Name
simple application, we won't be adding any Remove All
files at this moment.
Click Next.
4 Back Mext @ Cancel

Figure 3-5: Add existing headers, sources or other files if necessary




Following step allows you to quickly set
whether you want to include all libraries
in your project, or not. Even if all libraries
are included, they will not consume
any memory unless they are explicitely
used from within your code. The main
advantage of including all libraries is that
you will have over 500 functions available
for use in your code right away, and visible
from Code Assistant [CTRL+Space]. We
will leave this in default configuration:

Make sure to leave “Include All”
selected.

Click Next.

| Mew Project Wizard

Step 3: Select initial state for library manager:

Indude Libraries
@) Indude All (Default)

2 Include None (Advanced)

Selecting all libraries is recommended for beginners.

Selecting libraries manually using Library Manager

{recommended for advanced users) results in faster compilation, Library Manager Help

4 Back Mext 5 Cancel

Figure 3-6: Include all libraries in the project, which is a default configuration.




Mew Project Wizard lﬁj

After all the configuration is done, the

i i . Step 4: You have successfully created a new project. Click "Finish” to close a wizard.
final step allows you to do just a bit more.

There is a check-box called “Open Edit >
Project window to set Configuration J b Open Edit Project window to set Configuration bits
bits” at the final step. Edit Project is a v

specialized window which allows you to
do all the necessary oscillator and PLL
settings. We made sure that everything
is described in plain English, so you
will be able to do the settings without
having to open the datasheet. Anyway,
since we are only building a simple
application, we will leave it at default
configuration (internal L6MHz oscillator
with PLL disabled). Therefore, leave & Back ||  Finish Cancel
the checkbox unchecked.

Checking "Open Edit Project window ™ will open "Edit project form” after
closing this wizard. This enables you to set device configurations bits,

. Figure 3-7: Choose whether to open Edit Project window after dialog closes.
Click Finish.




New project is finally created. A new
source file called “LedBlinking.c” is
created and it contains the void main ()
function, which will hold the program.
You may notice that project is configured
according to the settings done in the New
Project Wizard.

_{PrujectSetﬁngs & |:_
EIQ,,’bDevice
Mame:  LM359B95 =

=/ MCU Clock [

Frequency: 16.000000| MHz

“=hugger Type

L3 mikroC PRO for ARM v00 - Clsers\Pubic Document War LegElinking mepar

File Edt View Project Build Run T6ok Help

T2 Code Explorer

¥ el

@ Functions
Giobals
Extems

(3] [ ledainkng.c

ToweDel
Tags

Includes
Ditctives

Wb Links
Image Links
Active Comments

——r -
S @D f

o e
e ek |

Frequency:|16.000000] MHz

= Budd Debioer Tipe |
Buid Tupe
© Rosse Debug
Debugger
® Eoinume okime

E

BB:NB¥HEE S80S 068& %

B Tvnld main()
all;

N,

P B AJABF o

e MRS s

«ools  Help

i &
|| Ledslinking.c

. Tvoid main ()
2 :

¥

A &

-EEE e lm i@

=

Emors warnings s
Line Message lo. Message Text
313 Insert c

ET— e

£ naries
& Project Level Defines
£ ImageFies
£ E=ROM Fils
& Active Comments Fies
@ £ OutputFes

24 (B850 & ihsek

S miroE

Figure 3-8: New blank project is created with your configuration



4. Code example
Time has come to do some coding. mikroC T
PRO for ARM® has the unique libraries that LedBllnklng.c - source code

enable you to do complicated tasks in a id .
single line of code. Built-in GPIO library L void main() {
enables you to set configure each PORT 2 /s PORTA digital
and enable pins that you need, without 3 et' . as digital output
. 4 GPIO Digital Output (&GPIO PORTA,
worrying about complex procedure that - - —

. . . 5) GPIO PINMASK ALL);
this operation requires. To demonstrate - - —
this, we will write our first line of code: 6 o

7 // Set PORTA initial value to zero
// Set PORTA as digital output 8 GPIO PORTA DATA = 0:
GPIO Digital Output ( - — !
&GPIO_PORTA, 9
_GPIO_PINMASK ALL); 10 while (1) {
Once we have enabled PORTA to act as L1 églgoggéiAP]gi;i — “GPTO PORTA DATA
digital output, we can now initialize PORTA 12 - — B - — !
with logic zeros on every PORT pin: 13
14 // Delay 1000 ms
// Set PORTA initial value to 0 15 Delay ms (1000) ;
GPIO PORTA DATA = 0; -
- - 16 }

. . " . 17
Finally, in a while() loop we will toggle the
PORTA value, and put a 1000 ms delay, so 18 }

the blinking is not too fast.
Figure 4-1: Complete source code of the PORTA LED blinking
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G mikroC PRO for ARM v.1.0.0 - C:\UsersiPublic\Documents\Work\LedBlinking. mcpar

T2 Code Explorer
i

File Edit View Project Build Run Tools Help

R ”%@QIQSDé HbB& %8 % d;

A N S

‘ + Blvoid main() {

& Functions
Giobals
Extems
TypeDef
Tags
Includes
Diectives
web Links
Image Links
Active Comments

// Set PORTA as digital output
4 GEIO Digital Gutput (6GBIC_PORTH,
- _GPIO_PINMASK ALL):

/¢ Set PORTA initial walue to zere
GPIO_PORTA DATA = 0

10 B while(l) {
// Toggie PORTA
GPIO_PORTA DATA = ~GPIO_PORTA DATA;

& Project Settings.
Bl Device

Name: LM359895

{85 MCU Clock

=1 Build/ Debugger Type
Build Type

Debugger

Frequency: 16000000 MHz

Fieleass ) Debug

Software ) Hardware

// Delay 1000 ms
- Delay_ms (1000);

) |

Figure 4-2: This is how the code looks
written in compiler code editor window

Project Manager [1/1] -LedBlnking.mepar 5 |22
ErEs el g A |
B |u LedBlinking.mcpar

=} D Sources
] Ledslinking.c
Header Files

Project Level Defines
Image Fies

EEPROM Files

Active Comments Files

|
‘ D ﬁ Output Files

[77?[?@[7@-

=7 Other Files

| o
: Library Manager | 2 Project Explorer

|2a B0 S| |

& mikreE 5

@ @] can_ser

[@] Compact_Flash
Compact_Flash_FAT16
Conversions
C_Math

C_stdib

C_String

C_Tvpe
EPSON_S1D13700
FLASH

Gled

Gled_Fonts

[ Messooes |l Quick Converter |

i Errors. Warrings Hints

e
Keypathxd
Led

Line. Message Mo,

Message Text

unit

«|

Lod_Constants
Manchester
Memianagsr

Mme

Mme_FAT16.

[ Mmc_Fat16_Config
[@] one_wiire
Port_Expander

Drintu

434 Insert

ChUsers\Public\Doc

ts\Work\LedBlinki
g
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5 . B u i I d i n : t h e S 0 u rce Name . Date modified Type Size

[ LedBlinking.asm 014-12-27 20T PM ASM File 1 KB
[ LedBlinking.brk 2011-12-27 11339 .. BRKFile 1 k8

2] LedBlinking.c 011-12-27 1144 .. CFile 1KB

When we are done writing our first Build | Run Tools Help & LedBlinking.c.ini 2011-12-2711:39 ... Configuration sett.. 1KE
LedBIlnklng COde, we can now build |‘5 Eﬂild Curl<Fo | =] LedBlinking.cfg 2011-12-27 207 PM  CFG File 1KB
) . |2 LedBlinking.cp 2011-12-27 207 PM CP File 18

the project and create a .HEX file Rebuild All Sources  Alt=Fd [ LedBlinking.dbg 2011-12-27 207PM  DEG File 912 KB
which can be loaded into our target & G, B LedBlinking.dct 2011-12-27 207 PM  Adobe lllustrator S.., 652 KB
microcontroller, so we can test the . || LedBlinking.dit 2014-12-27 207 PM  DLTFile 13K8
P Stop Build All Ctrl+F12 |_| LedBlinking.emcl 2011-12-27 207 PM EMCL File 2KB

program on real hardware. “Building ) [[Z] LedBlinking.hex 2011-12-27 207 M HEX File 5KB
includes compilation, linking and %y Build+ Program  Cerl-FLL | LecBlinking log 2011-12-27 207 PM  Text Document 3KB
optimization which is all done automatically. Build your code by clicking = -*#"mne ™t IR, e o
LedBlinking.mcpar 2011-12-27 207 PM mikroC PRO for A.., 2KB

on the 4 icon in the main toolbar, or simply go to Build menu and || | cisiinking.mepar._callertablett 20111227 207 B14 14T File 1KB
click Build [CTRL+F9]. Message window will report the details of L LedBlinkinguser.dic HNEAZIIZOTEM,  Tert DoounE kB

the building process (Figure 5-2). Compiler automatically creates Figure 5-1: Listing of project files after building is done
necessary output files. LedBlinking.hex (Figure 5-1) is among them.

Messages | i Quick Canverter Figure 5-2:

| Errors Warnings Hints | After the
successful

Line Message Mo, Message Text Unit i . .
compilation

a 1144 Static RAM (bytes): 0 Dynamic RAM (bytes): 93301 Static RAM (bytes): 0 Dynan .

0 1144 Used ROM {bytes): 1562 (1%) Free ROM (bytes): 260532 (39%) Used ROM (bytes): 1562 (1% and linking,

a 125 Praject Linked Successfully LedBlinking. mcp32 — the message

a 128 Linked in 1061 ms = .

a 129 Project ‘LedBlinking.mcpar’ completed: 1576 ms \\ window

a 103 Finished successfully: 27 Dec 2011, 14:07:25 LedBlinking.mcpar = should look

<] i | r something

18:2 Insert Compiled Ch\Users\Public\Documents\Work\LedBlinking.c like this
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If you need to change the target microcontroller or clock speed, you don't have to go through the new project wizard all over again. This
can be done quickly in the Edit Project window. You can open it using Project->Edit Project [CTRL+SHIFT+E] menu option.

Edit Project

==

Oscillator Source

|105€ Internal Osalator default)

Crystal Value

|5.000 MHz(reset value)

Enable System Clock Divider

| Disabled

System Clok Divisor

[iss

PLL Power Down

|PLL Pawer Down is enabled

PLL Bypass

iPLL is bypassed

Internal Oscillator Disable

[Interna\ Osdllater(I05C) is enabled

Main Oscillator Disable

[ain oscilater (MoSC) is disabled

Aute Clock Gating

|Run-Mode Clock Gating Conirol used

Use RCC2 (when set, overrides the RCC register fields)

|Dn notuse RCC2

Oscillator Source 2

[IOSC Internal Oscillator{default)

MCU and Osdillator

MCU Name [Lm3somes -
————y
Osdllator Frequency [MHz] 15.000082+

Build Type Heap
@ Release © Debug Size 2000

Configuration Registers

RCC

RCCZ

: 0x7803AD1
70 : 0x7C06810

General Output Settings ...

Load Scheme

Save Scheme

Default

oK

Cancel

Figure 6-1: Edit Project Window

To change your MCU, just select the
desired microcontroller from the
dropdown list.

To change your oscillator settings
enter the oscillator value and adjust
oscillator configuration registers us-
ing drop-down boxes.

Several most commonly used oscil-
lator settings can be loaded using
the provided oscillator “schemes”.
Load the desired scheme by clicking
the Load Scheme button.

Select whether to build a Debug
HEX, which is necessary for hardware
debugging, or a final Release HEX.



| tbrary Manager | %2 Praject Explorer |

2 B C:\Users\Puch\Documents\MiM’oelektron@]

& ST

mikroC PRO for ARM® comes with over 195 examples which demonstrate a variety of
features. They represent the best starting point when developing a new project. You will find
projects written for MikroElektronika development boards, additional boards, internal MCU
modules and other examples. This gives you a head start in development, and you don't have
to do it all from scratch. In most cases, you can combine different simple projects to create a
more complex one. For example, if you want to build a date, time and temperature semaphore
on 7-segment display, you can combine RTC and temperature sensor examples with Seven
Segment Display example and do the job in much less time. All projects are delivered with
working .HEX files, so you don't have to buy a compiler license in order to test them. You can
load them into your development board right away without the need for building them.

If you want to find answers to your questions on many interesting topics we invite you to
visit our forum at http://www.mikroe.com/forum/ and browse through more than 220,000
posts. You are likely to find just the right information for you.

=) T

Development Systems
= | EasyMx PRO v7 for Stelaris ARM
s ADC Demo

Button

Calculator

CAN

EEPROM (12C)
Ethernet Demo
Joystick

Led Blinking

{ LedBlinking.mcj

Mapping
MMC
Mp3
One Wire
Serial Flash
Simple Maze
Sound

par

'@ ) usB
mikromedia 5 for TIVA
mikromedia Plus for Stelaris ARM
mikroMMB for StelarisM3

Digital Signal Processing

Extra Boards

i)

B
e

¢ B | Internal MCU modules
I

Other

k; _1 MyProject.mcpar

On the other hand, if you want to download more free projects and libraries, or share your
own code, please visit the Libstock website http://www.libstock.com/. With user profiles,
you can get to know other programmers, and subscribe to receive notifications on their code.

Figure 6-1: Project explorer window
enables you to easily access provided
examples and load them quickly



HIGH RISK ACTIVITIES

The products of MikroElektronika are not fault - tolerant nor designed, manufactured or intended for use or resale as on - line control equipment in
hazardous environments requiring fail - safe performance, such as in the operation of nuclear facilities, aircraft navigation or communication systems,

air traffic control, direct life support machines or weapons systems in which the failure of Software could lead directly to death, personal injury or
severe physical or environmental damage (‘High Risk Activities'). MikroElektronika and its suppliers specifically disclaim any expressed or implied
warranty of fitness for High Risk Activities.




If you want to learn more about our products, please
visit our website at www.mikroe.com. If you are
experiencing some problems with any of our products or
just need additional information, please place your ticket
at www.mikroe.com/support If you have any questions,
comments or business proposals, do not hesitate to
contact us at office@mikroe.com
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Mikro€Elektronika Ltd.
www.mikroe.com
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